
Chapter 1

Getting to Know Microsoft 
Office 2007

In This Chapter
� Starting an Office 2007 program

� Understanding the Office 2007 user interface

� Using the Quick Access toolbar

� Customizing an Office 2007 program

� Exiting from Office 2007

Microsoft Office 2007 consists of five core programs: Word, Excel,
PowerPoint, Access, and Outlook. Each of these core programs spe-

cializes in manipulating different data. Word manipulates words, sentences,
and paragraphs; Excel manipulates numbers; PowerPoint manipulates text
and pictures to create a slide show; Access manipulates data, such as inven-
tories; and Outlook manipulates personal information, such as e-mail
addresses and phone numbers.

Although each Office 2007 program specializes in storing and manipulating
different types of data, they all work in similar ways. First, you have to enter
data into an Office 2007 program by typing on the keyboard or loading data
from an existing file. Second, you have to tell Office 2007 how to manipulate
your data, such as underlining, enlarging, coloring, or deleting it. Third, you
have to save your data as a file.

To help you understand this three-step process of entering, manipulating,
and saving data, Office 2007 offers similar commands among all its programs
so you can quickly jump from Word to PowerPoint to Excel without having to
relearn entirely new commands to use each program. Even better, Office 2007
rearranges its numerous commands so finding the command you need is
faster and easier than ever before. (If you think this implies that previous ver-
sions of Microsoft Office were clumsy and hard to use, you’re right.)
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If you’re already familiar with computers and previous editions of Microsoft
Office, you may want to browse through this chapter just to get acquainted
with how Office 2007 rearranges common program commands. If you’ve
never used a computer before or just don’t feel comfortable using Microsoft
Office, read this chapter first.

Loading an Office 2007 Program
The first step to using Office 2007 is loading the program you want to use. To
load any Office 2007 program, follow these steps:

1. Click the Start button on the Windows taskbar.

A pop-up menu appears.

2. Choose All Programs.

Another pop-up menu appears.

3. Choose Microsoft Office.

A list of programs appears on the Start menu, as shown in Figure 1-1.

Figure 1-1:
You can find
every Office

2007
program
from the

Start menu.

10 Part I: Getting to Know Microsoft Office 2007

05_009233 ch01.qxp  11/15/06  11:22 AM  Page 10



4. Choose the Office 2007 program you want to use, such as Microsoft
Word or Microsoft PowerPoint.

Your chosen program appears on the screen.

Getting to Know the New User Interface
Office 2007 offers a new user interface for Word, Excel, PowerPoint, Access,
and some parts of Outlook. This new user interface consists of three parts, as
shown in Figure 1-2:

� Office Button

� Quick Access toolbar

� Ribbon

Office Button

Quick Access toolbar

Ribbon

Figure 1-2:
The three

parts of the
new

Microsoft
Office 2007

user
interface.
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The File menu
The File menu contains commands for opening, saving, printing, and closing
a file. In Word, a file is called a document. In Excel, a file is called a workbook.
In PowerPoint, a file is called a presentation. In Access, a file is called a database.

In previous versions of Office, the File menu was clearly labeled File. In Office
2007, the File menu appears when you click the Office Button in the upper-left
corner (refer to Figure 1-2).

You can display the File menu by clicking the Office Button or by pressing Alt+F.

Creating a new file
When you first load an Office 2007 program, it automatically creates an
empty file for you to use right away. In case you need to create a new file after
you’ve already loaded an Office 2007 program, follow these steps:

1. Click the Office Button.

A drop-down menu appears, as shown in Figure 1-3.

Figure 1-3:
The Office

Button
menu

displays
different

commands
for opening,
creating, or

closing your
files.
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2. Choose New.

A New dialog box appears, as shown in Figure 1-4. Depending on which
program you’re using, the dialog box may read New Document (for
Word), New Workbook (for Excel), and so on.

3. Click Blank (such as Blank Document or Blank Workbook) and then
click the Create button.

Depending on which program you’re using, you may choose Blank
Document for Word or Blank Presentation for PowerPoint. A blank file
appears ready for you to start storing data in it.

Creating a new file from a template
Rather than create a blank file, you may find it easier to use a template
instead. A template contains predefined formatting for creating different
types of files easily, such as calendars, newsletters, sales reports, or a corpo-
rate slide show presentation. Office 2007 provides three types of templates:

� Office 2007 templates installed on your computer

� Templates available over the Internet on the Microsoft Web site

� Existing files that you create and format yourself

Figure 1-4:
A New

dialog box
lets you

create a
blank file or

use an
existing

template.
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Using an Office 2007 template on your computer
Installing Office 2007 automatically installs dozens of templates for Word,
Excel, PowerPoint, and Access. To use one of these templates, follow these
steps:

1. Click the Office Button and choose New.

A New window appears (refer to Figure 1-4).

2. Click Installed Templates.

The New window displays all the installed templates on your computer.

3. Click the template you want to use and then click the Create button.

Office 2007 creates a new file based on your chosen template.

Downloading and using a template off Microsoft’s Web site
Microsoft provides a huge library of templates that you can download from
its Web site. To retrieve these templates, you need to connect to the Internet
and then follow these steps:

1. Click the Office Button and then choose New.

A New window appears (refer to Figure 1-4).

2. Click a category underneath Microsoft Office Online, such as
Calendars or Award Certificates.

The New window displays all the templates available from the Microsoft
Web site, as shown in Figure 1-5.

Figure 1-5:
Microsoft’s

Web site
offers new
templates

that you can
use for all

your Office
2007

programs.
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3. Click the template you want to use and then click the Download
button.

Office 2007 downloads and creates a new file based on your chosen 
template.

Opening an existing file
When you load an Office 2007 program, you’ll probably want to edit a file that
you had created and modified before. To open an existing file, you need to
tell Office 2007 the location and name of the file you want to open. Just follow
these steps:

1. Click the Office Button and then choose Open.

An Open dialog box appears, as shown in Figure 1-6.

2. (Optional) To choose a different drive to look for files, click Computer
under the Favorite Links panel (see the left side of Figure 1-6). Then
click the drive where you want to load the file, such as the C: drive.

3. (Optional) Click a folder and then click Open to search for a file inside
a folder. Repeat this step as many times as necessary.

4. Click the file you want to open and then click Open.

Your chosen file appears ready for editing.

Figure 1-6:
The Open

dialog box
lets you
change

drives and
folders to

find the file
you want 

to use.
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When you click the Open command under Microsoft Word, Excel,
PowerPoint, and Access, an additional window appears to the right that con-
tains a list of the last files you opened. If you want to load a file you’ve
recently used, just click that filename to load that file.

Saving files
Saving a file stores all your data on a hard disk or other storage device (such
as a Compact Flash card). The first time you save a file, you need to specify
three items:

� The drive and folder to store your file

� The name of your file

� The format to save your file

The drive and folder where you store your files is completely arbitrary.
However, it’s a good idea to store similar files in a folder with a descriptive
name, such as Tax Evasion Information for 2008 or Extortion Letters to
Grandma. By default, Office 2007 stores all your files in the Documents folder.

The name of your file is also completely arbitrary, but it’s also a good idea to
give your file a descriptive name such as Latest Resume to Escape My Dead-
End Job or Global Trade Presentation for World Domination Meeting on
September 9, 2008.

The format of your file defines how Office 2007 stores your data. The default
file format is known as Office 2007 format, which simply means that only
people with Office 2007 can reliably open and view the contents of that file. If
you want to share your files with people who don’t use Office 2007, you have
to save your files in a different file format.

Saving a file for Office 2007
If you’re the only person who needs to view and edit your files, you can save
a file in Office 2007 format by following these steps:

1. Click the Office Button.

A drop-down menu appears.

2. Click Save.

If this is the first time you’re saving the file, a Save As dialog box
appears, as shown at the top of Figure 1-7.
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For a quick way to choose the Office Button➪Save command, click the
Save icon that appears to the right of the Office Button or press Ctrl+S.

3. (Optional) To specify a drive and folder to save your file, click Browse
Folders.

This causes the dialog box to expand, as shown in the bottom dialog box
in Figure 1-7. Now you can click Computer, under Favorite Links, and
then click a folder. Or, click the New Folder button; when the New Folder
dialog box appears, type a name for your new folder and then click OK.

4. Click in the File Name text box and type a descriptive name for your
file.

5. Click Save.

After you’ve saved a file, you’ll only have to go through Steps 1 and 2 because
you don’t have to specify a location and filename to save an existing file.

Figure 1-7:
The Save As

dialog box
lets you

choose the
name, file

format, and
a location to

save your
file.
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Saving a file for older versions of Microsoft Office
If you need to share files with people using older versions of Microsoft Office,
you need to save your files in a different file format known as 97-2003, such as
Word 97-2003 Document or PowerPoint 97-2003 Presentation.

This special 97-2003 file format saves Office 2007 files so that previous ver-
sions of Microsoft Office 97/2000/XP/2003 can open and edit your files.

When you save files in the 97-2003 format, Microsoft Office 2007 saves your
files with a three-letter file extension, like .doc or .xls. When you save files
in the Office 2007 format, Microsoft Office 2007 saves your files with a four or
five-letter file extension, such as .docx or .pptx, as shown in Table 1-1.

Table 1-1 File Extension Names Used by Different Versions 
of Microsoft Office

Program Microsoft Office Microsoft Office 
2007 File Extension 97-2003 File Extension

Microsoft Word .docx .doc

Microsoft Excel .xlsx .xls

Microsoft PowerPoint .pptx .ppt

Microsoft Access .accdb .mdb

To save your Office 2007 files as a 97-2003 format, follow these steps:

1. Click the Office Button and then choose Save As.

A Save As dialog box appears.

2. Click in the Save as Type list box.

A list of different formats appears, as shown in Figure 1-8.

When you choose the Save As command in Step 1, you’re making a copy
of your original file.

3. Choose the 97-2003 format option, such as Word 97-2003 Format or
Excel 97-2003 Format.

The Save as Type list box displays a huge list of file formats, such as
XML Data or Text. Most programs can accept files stored in the 97-2003
format, but many older programs cannot, so you may have to resort to
saving a file in one of these other formats instead.
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4. (Optional) Click in the File Name text box and type a descriptive name
for your file.

5. Click Save.

Closing a file
When you’re done editing a file, you need to close it. Closing a file simply
removes the file from your screen but keeps your Office 2007 program run-
ning so you can edit or open another file. If you haven’t saved your file, clos-
ing a file will prompt you to save your changes.

To close a file, follow these steps:

1. Click the Office Button and then choose Close.

If you haven’t saved your file, a dialog box appears asking whether you
want to save your changes.

For a faster way to choose the Close command, press Ctrl+F4.

2. Click Yes to save your changes, No to discard any changes, or Cancel
to keep your file open.

If you click either Yes or No, Office 2007 closes your file.

Using the Quick Access toolbar
The Quick Access toolbar appears to the right of the Office Button (refer to
Figure 1-2) near the top of the screen, displaying icons that represent com-
monly used commands such as Save, Undo, and Redo as shown in Figure 1-9.

Figure 1-8:
The Save as
Type list box

lets you
choose a

file format
for saving

your file.
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Using the Quick Access icons
If you click the Save icon in the Quick Access toolbar, Office 2007 saves your
current file. If you’re saving a new file, a dialog box pops up, asking you to
choose a name for your file.

If you click the Print icon in the Quick Access toolbar, Office 2007 immediately
prints one copy of your entire file through the default printer. (If you want to
specify a different printer to use, the number of copies to print, or specific
pages to print, click the Office Button and choose Print instead.)

The Redo icon reverses the last Undo command you chose. For example, 
if you delete a paragraph, Office 2007 makes that paragraph disappear. 
Then if you immediately click the Undo icon, the paragraph magically reap-
pears. If you immediately click the Redo icon, the Redo command reverses
the Undo command and deletes the paragraph once more.

The Undo icon is unique in that it offers two ways to use it. First, you can
click the Undo icon to undo the last action you chose. Second, you can click
the downward-pointing arrow that appears to the right of the Undo icon to
display a list of one or more of your previous actions, as shown in Figure 1-10.

Figure 1-10:
The Undo

icon
displays a

list of
actions you

can undo.

Save

Undo

Redo Customize
Quick Access
toolbar

Figure 1-9:
The Quick

Access
toolbar

provides
one-click
access to
the most

commonly
used

commands.
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The most recent action you chose appears at the top of this list, the second
most recent action appears second, and so on. To undo multiple commands,
follow these steps:

1. Click the downward-pointing arrow that appears to the right of the
Undo icon in the Quick Access toolbar.

2. Move the mouse pointer to highlight one or more actions you want to
undo.

3. Click the left mouse button.

Office 2007 undoes all the multiple actions you selected.

Adding icons
The Quick Access toolbar is designed to put your most commonly used com-
mands where you can always find them. To add other icons to the Quick
Access toolbar, follow these steps:

1. Click the Customize Quick Access Toolbar arrow (refer to Figure 1-9).

A pull-down menu appears.

You can add an icon to the toolbar by just clicking on an icon name,
such as Quick Print or New, from the pull-down menu.

2. Click More Commands.

An Options window appears, as shown in Figure 1-11. The panel on the
right shows all the current icons on the Quick Access toolbar. The panel
on the left shows all the additional icons you can add.

Figure 1-11:
The Options
window lets

you select
the icons

you want to
add to the

Quick
Access
toolbar.
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3. Click in the Choose Commands From list box and choose a menu title,
such as File or Page Layout.

The left panel displays a list of icons and commands.

4. Click an icon and then click the Add button.

5. (Optional) Repeat Steps 3 and 4 for each additional icon you want to
add to the Quick Access toolbar.

6. Click OK.

Your chosen icon (or icons) now appears on the Quick Access toolbar.

Removing icons
You can remove icons from the Quick Access toolbar at any time. To remove
an icon, follow these steps:

1. Right-click an icon on the Quick Access toolbar.

A pull-down menu appears.

2. Click Remove from Quick Access Toolbar.

Office 2007 removes your selected icon from the Quick Access toolbar.

Moving the Quick Access toolbar
The Quick Access toolbar can appear in one of two places:

� Above the Ribbon (its default location)

� Below the Ribbon

To move the Quick Access toolbar, follow these steps:

1. Click the Customize Quick Access Toolbar arrow.

A pull-down menu appears.

2. Choose Place Quick Access Toolbar Below (or Above) the Ribbon.

If the Quick Access toolbar currently appears over the Ribbon, you’ll see
the Place Quick Access Toolbar Below the Ribbon command. If the
Quick Access toolbar appears under the Ribbon, you’ll see the Place
Quick Access Toolbar Above the Ribbon command.

Minimizing the Ribbon
You can tuck the Ribbon out of sight temporarily so it only appears when you
click on a tab such as Home or Insert. To hide the Ribbon, follow these steps:

22 Part I: Getting to Know Microsoft Office 2007
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1. Click the downward-pointing arrow that appears to the right of the
Undo icon in the Quick Access toolbar.

A pull-down menu appears.

2. Click Minimize the Ribbon.

Office 2007 hides the Ribbon and only displays the tabs. To display the
Ribbon again, repeat these two steps.

Using the Ribbon
The Ribbon organizes commands into categories called contextual tabs. Each
tab displays a different group of commands. For example, the Page Layout tab
displays only those commands related to designing a page, and the Insert 
tab displays only those commands related to inserting items into a file, such
as a page break or a picture, as shown in Figure 1-12.

Using the Ribbon is a two-step process. First, you must click the tab that con-
tains the command you want. Second, you click the actual command.

Tabs act exactly like traditional pull-down menus. Whereas a pull-down menu
simply displays a list of commands, tabs display a list of icons that represent
different commands.

Deciphering Ribbon icons
The main idea behind organizing commands within tabs is to avoid over-
whelming you with a barrage of different commands. Although most icons
include a short text description, you can get additional help deciphering dif-
ferent icons through ScreenTips, which typically displays the following, as
shown in Figure 1-13:

Figure 1-12:
Each tab

displays a
different
group of

related
commands.
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� The official name of the command (which is Format Painter in 
Figure 1-13)

� The equivalent keystroke shortcut you can use to run the command
(which is Ctrl+Shift+C in the figure)

� A short explanation of what the command does

To view the ScreenTip for a command, move the mouse pointer over a com-
mand and wait a few seconds for the ScreenTip appear.

Shortcut keystrokes let you choose a command from the keyboard without
the hassle of clicking a tab and then clicking the command buried inside that
tab. Most shortcut keystrokes consist of two or three keys, such as Ctrl+P or
Ctrl+Shift+C.

Using Live Preview
In the past, you might have known what a particular command did, but you
would never know how it would affect your file until after you chose that com-
mand. Oftentimes, you might choose a command, see how it changed your file,
and then undo the change because it may not be what you really wanted.

To avoid this hassle of constant experimentation with different commands,
Office 2007 offers a feature called Live Preview. Live Preview lets you move
the mouse pointer over certain icons displayed in a tab and then immediately
see the changes displayed in your current file.

To use Live Preview, follow these steps:

1. Move the cursor (or click the mouse) on an object (text, picture, table,
and so on) that you want to change.

2. Move the mouse pointer over any command.

Office 2007 shows you how your chosen object will look if you choose
the command, as shown in Figure 1-14.

Figure 1-13:
ScreenTips

explain
what each
command

does.
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3. Click the command to change your object (or move the mouse pointer
away from the command so you don’t choose that command).

In Word, Live Preview will not work if you display your document in Draft view.

Giving commands to Office 2007
To give a command to Office 2007, you need to follow these basic steps:

1. Select an item (text, picture, table, and so on) that you want to modify.

2. Click a tab that contains the command you want.

3. Click the command you want to use.

Command icons work in one of three ways, as shown in Figure 1-15:

� Clickable icons: Clicking an icon immediately chooses a command to
alter your data. The Bold and Italic icons are examples of icons that you
click only once to choose them.

� List box icons: Some icons display a downward-pointing arrow to the
right. Clicking these icons displays a list of additional options. The Font
and Font Size icons are examples of list box icons.

� Gallery icons: Some icons display a downward-pointing arrow that dis-
plays a drop-down list of additional commands, called a gallery.

Figure 1-14:
Live

Preview lets
you see

how a
particular
command

could
change your

file.
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Customizing an Office 2007 Program
If you want to modify how a particular Office 2007 program works, you can
customize its features. To customize an Office 2007 program, follow these
steps:

1. Load the Office 2007 program you want to customize.

2. Click the Office Button.

A pull-down menu appears.

3. Click the Options button in the bottom-right corner, such as Word
Options or Excel Options.

An Options dialog box appears, as shown in Figure 1-16.

List box Gallery

Figure 1-15:
Commands

appear as
icons, list
boxes, or
galleries.

26 Part I: Getting to Know Microsoft Office 2007

05_009233 ch01.qxp  11/15/06  11:22 AM  Page 26



4. Click a category, such as Save or Display.

The Options dialog box displays multiple options for you to customize.

5. Click OK when you’re done choosing different customizing options.

If you click the Save category in Step 4, you can define a default file format
and file location for storing files for each Office 2007 program (Word, Excel,
and so on).

Exiting Office 2007
No matter how much you may love using Office 2007, eventually there will
come a time when you need to exit an Office 2007 program and do something
else with your life. To exit from any Office 2007 program (except Outlook),
choose one of the following:

� Click the Close box in the upper-right corner of the Office 2007 window.

� Click the Office Button and then click the Exit button (refer to Figure 1-3).

� Press Alt+F4.

Figure 1-16:
The Options

dialog box
lets you

change how
an Office

2007
program
behaves.
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If you try to close an Office 2007 program before saving your file, a dialog box
pops up to give you a chance to save your file. If you don’t save your file
before exiting, you’ll lose any changes you made to that file.

To exit Microsoft Outlook, just choose File➪Exit.
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